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Preface

Profile

Before You Begin This Course

Before you begin this course, you should have the following qualifications:

•  Knowledge of the manufacturing processes

Prerequisites

•  Defining & Maintaining Items (Inventory)

•  Creating Bill of Materials (BOMs)

How This Course Is Organized

R11i Oracle BOM and Engineering: Defining and Maintaining Engineering Items
is an instructor-led course featuring lecture and hands-on exercises.  Online
demonstrations and written practice sessions reinforce the concepts and skills
introduced.
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Related Publications

Oracle Publications

Title Part Number

Oracle Engineering User’s Guide A75090-01

Oracle Inventory User’s Guide A83507-01

Oracle Bill of Material User’s Guide A75087-01

Additional Publications

•  System release bulletins

•  Installation and user’s guides

•  read.me files

•  Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.

Convention Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
(OG_GET_LAYER

(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.

Notations :

(N) = Navigator

(M) = Menu

(T) = Tab



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Oracle BOM and Engineering: Defining and Maintaining Engineering Items Table of Contents
vii

(I) = Icon

(H) = Hyperlink

(B) = Button

Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.
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3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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R11i Oracle BOM and Engineering:
Defining and Maintaining

Engineering Items

R11i Oracle BOM and Engineering:
Defining and Maintaining

Engineering Items
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ObjectivesObjectives

After completing this course you should be able to do
the following:
• Create engineering items
• Copy from item templates
• Search for engineering items
• View item information and revise item attributes
• Enable organization assignments
• Create item catalog groups
• Create cross references, relationships and

documents
• Create deletion groups

After completing this course you should be able to do
the following:
• Create engineering items
• Copy from item templates
• Search for engineering items
• View item information and revise item attributes
• Enable organization assignments
• Create item catalog groups
• Create cross references, relationships and

documents
• Create deletion groups
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Using Oracle Applications Help
 Within a Window

Using Oracle Applications Help
 Within a Window

Any window launched from the Oracle Navigator will
link to online help. Select Help—>Window Help from
the menu bar. Oracle Applications Help displays
detailed information about the window you opened,
including step-by-step instructions for entering
information in each field in the window.
Note: The Library topic contains help for products.

Any window launched from the Oracle Navigator will
link to online help. Select Help—>Window Help from
the menu bar. Oracle Applications Help displays
detailed information about the window you opened,
including step-by-step instructions for entering
information in each field in the window.
Note: The Library topic contains help for products.

Help Note

You can launch Oracle Help using the toolbar “?” icon only from a window that is
open from the Navigator. If you launch Oracle Help from a window that is opened
via the menu bar, a button, or pop up window, you will receive a http://404 - no
data found error.
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Searching Oracle Applications HelpSearching Oracle Applications Help

1. From any window within an Oracle Application
select Help—>Window Help from the menu bar.

2. The Oracle Applications Help window is displayed.
3. Enter your search criteria, enclosed within

quotation marks, in the Find field and click Find.
4. Select a topic to view detailed information.
Note: Select Search Instructions for help when
searching Oracle Applications Help.

1. From any window within an Oracle Application
select Help—>Window Help from the menu bar.

2. The Oracle Applications Help window is displayed.
3. Enter your search criteria, enclosed within

quotation marks, in the Find field and click Find.
4. Select a topic to view detailed information.
Note: Select Search Instructions for help when
searching Oracle Applications Help.

Help Note

You can only launch Oracle Help using the toolbar “?” icon from a window that is
open from the Navigator. If you launch Oracle Help from a window that is opened
via the menu bar, a button, or pop up window, you will receive a http://404 - no
data found error.
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Engineering and Manufacturing ItemsEngineering and Manufacturing Items

• Engineering items are items that your engineering
function creates and that are not ready for
production (created in Oracle Engineering).

• Manufacturing items are items you use in
production (created in Oracle Inventory).

• Engineering items are items that your engineering
function creates and that are not ready for
production (created in Oracle Engineering).

• Manufacturing items are items you use in
production (created in Oracle Inventory).
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Engineering and Manufacturing ItemsEngineering and Manufacturing Items

How do they differ?
• Engineering items have the item attribute

engineering item selected.
• Manufacturing items have the item attribute

engineering item.
• Engineering items are not visible in Oracle

Inventory.

How do they differ?
• Engineering items have the item attribute

engineering item selected.
• Manufacturing items have the item attribute

engineering item.
• Engineering items are not visible in Oracle

Inventory.

Engineering and Manufacturing Items
Engineering flag is not visible in Oracle Inventory.
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Engineering and Manufacturing ItemsEngineering and Manufacturing Items
Perform the same item functions with engineering
items that you do with production items, including
the following:

– Create item revisions
– Perform stock movements and valuation
– Perform cost rollup
– Perform material planning
– Sell and ship to customers
– Buy on purchase orders or internal

requisitions
– Make on and issue to discrete jobs and

repetitive schedules

Perform the same item functions with engineering
items that you do with production items, including
the following:

– Create item revisions
– Perform stock movements and valuation
– Perform cost rollup
– Perform material planning
– Sell and ship to customers
– Buy on purchase orders or internal

requisitions
– Make on and issue to discrete jobs and

repetitive schedules



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Oracle BOM and Engineering: Defining and Maintaining Engineering Items
Chapter 1 - Page 11

Engineering and Manufacturing Items

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Engineering and Manufacturing ItemsEngineering and Manufacturing Items

• Prototype items that are not ready for production.• Prototype items that are not ready for production.

ItemsItems

EngineeringEngineering ProductionProduction

Engineering and Manufacturing Items
The windows that you use to create engineering and manufacturing items are
identical. They differ only in the following ways:

• You create and change engineering items using the Oracle Engineering
windows. You can create and change manufacturing items using the
Oracle Inventory forms.

• When your engineering items are ready for production, you can transfer or
copy them to Oracle Inventory as manufacturing items. When you transfer
an engineering item, it becomes a manufacturing item. When you copy an
engineering item, it remains and you create a manufacturing item with a
different item number.
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Engineering Master ItemEngineering Master Item

• With the Master Item window, you can define and
update items and the attributes associated with
them e.g., description, lead time, unit of measure
(UOM), lot control, and etc).

• With the Master Item window, you can define and
update items and the attributes associated with
them e.g., description, lead time, unit of measure
(UOM), lot control, and etc).

Engineering Master Item

Use this window to create and change engineering items in the same way that you
use the corresponding Oracle Inventory window to create and change production
items.

(N) Prototypes > Items > Master Items

(Help) Oracle Inventory > Items > Defining Items
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Engineering Master ItemEngineering Master Item

Main
Inventory
Bill of Materials
(BOM)
Costing
Purchasing

Receiving
Physical attributes
General
MPS/MRP
Planning

Lead times
WIP
OM
Invoicing
Service
Web option

Much of the information for an item is optional. You
define only the information you need to maintain the
item in the following tabs:

Much of the information for an item is optional. You
define only the information you need to maintain the
item in the following tabs:
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AgendaAgenda
• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Item TemplatesItem Templates

• Templates are defined sets of attributes that you
can reuse to create many similar items. Templates
make initial item definition easier.

• If attribute item template is null, it will not change
a pre-set item attribute.

• When you apply a template to an item, you copy all
existing, non-blank attribute values from the
template to the item.

• You may apply multiple templates to a single item.
The last values assigned are retained, and blanks
don’t overlay assigned values.

• Item templates change item attributes
consistently.

• Templates are defined sets of attributes that you
can reuse to create many similar items. Templates
make initial item definition easier.

• If attribute item template is null, it will not change
a pre-set item attribute.

• When you apply a template to an item, you copy all
existing, non-blank attribute values from the
template to the item.

• You may apply multiple templates to a single item.
The last values assigned are retained, and blanks
don’t overlay assigned values.

• Item templates change item attributes
consistently.
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Engineering Master ItemEngineering Master Item

Assemble to
order (ATO)
Model
ATO Option
Class
ATO Item
Finished Good
Kit
Purchased
Reference Item
Subassembly

Supply Item
Freight
Product Family
Outside
Processing
Item
Pick to Order
(PTO) Model
PTO Option
Class

 Templates provided by Oracle Templates provided by Oracle
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Item Template SummaryItem Template Summary

• The Find button on the Find Item Templates
window displays the searched template summary
information in the Item Templates Summary
window.
– Template
– Description
– Organization
– Item status
– Primary UOM
– User item type
– Bills of Material item type
– Checkboxes for status codes

• The Find button on the Find Item Templates
window displays the searched template summary
information in the Item Templates Summary
window.
– Template
– Description
– Organization
– Item status
– Primary UOM
– User item type
– Bills of Material item type
– Checkboxes for status codes

Items Templates

Use this window to create and change item attribute templates. Use the same item
templates in Oracle Engineering as in Oracle Inventory.

(N) Prototypes > Items > Template (B) Find > Item Templates
Summary (B) Open or (B) New

(Help) Oracle Inventory > Items > Defining Items
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Item Template Summary WindowItem Template Summary Window

• The Open button utilizes existing template
information.

• The New button allows for the entering of a new
template.

• The Open button utilizes existing template
information.

• The New button allows for the entering of a new
template.

(N) Prototypes > Items > Template (B) Find > Item Templates
Summary (B) Open or (B) New

(Help) Oracle Inventory > Items > Defining Items
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Copying From TemplatesCopying From Templates

• Use the copy function from the tools menu in the
Engineering Master Item window. This opens the
Copy From window, where you can use to copy
item attributes from one item to another or from a
template.

• You can also create a hybrid template by copying
attributes from multiple templates.

• Use the copy function from the tools menu in the
Engineering Master Item window. This opens the
Copy From window, where you can use to copy
item attributes from one item to another or from a
template.

• You can also create a hybrid template by copying
attributes from multiple templates.

(N) Prototypes > Items > Master Items (M) Tools, Copy From

(N) Prototypes > Items > Template (B) New (M) Copy Template

(Help) Oracle Inventory > Items > Defining Items
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Searching Engineering ItemsSearching Engineering Items

Use the Item Search window to search for items
based on any combination of criteria you specify:

– Having a particular cross-reference
– Item category
– Purchasing information
– Quantity types
– Item catalog
– Matching specified inventory detail, or having

a specified descriptive element value
– Related to or that are substitutes for a

specified item

Use the Item Search window to search for items
based on any combination of criteria you specify:

– Having a particular cross-reference
– Item category
– Purchasing information
– Quantity types
– Item catalog
– Matching specified inventory detail, or having

a specified descriptive element value
– Related to or that are substitutes for a

specified item

(N) Prototypes > Items > Item Search (B) Find

(Help) Oracle Inventory > Items > Searching for Items
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Searching Engineering ItemsSearching Engineering Items

You can specify as much or as little criteria as you
want.
You can specify as much or as little criteria as you
want.
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Search ResultsSearch Results

View search results in the Item Search window.
– Item
– Description
– Organization
– UOM

View search results in the Item Search window.
– Item
– Description
– Organization
– UOM
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Review QuestionReview Question

Which window allows users to define and update
items?
1. Manual Items Define
2. Cross Reference Item
3. Allocation Items
4. Master Item
5. Find Item Template

Which window allows users to define and update
items?
1. Manual Items Define
2. Cross Reference Item
3. Allocation Items
4. Master Item
5. Find Item Template
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Answer to Review QuestionAnswer to Review Question

Which window allows users to define and update
items?
1. Manual Items Define
2. Cross Reference Item
3. Allocation Items
4. Master Item
5. Find Item Template

Which window allows users to define and update
items?
1. Manual Items Define
2. Cross Reference Item
3. Allocation Items
4. Master Item
5. Find Item Template
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Review QuestionReview Question

The Item Templates Summary window has the
following buttons:
1. Engineering and Inventory buttons
2. Utility and  Item buttons
3. Search and Query buttons
4. New and Open buttons
5. Error and Existing buttons

The Item Templates Summary window has the
following buttons:
1. Engineering and Inventory buttons
2. Utility and  Item buttons
3. Search and Query buttons
4. New and Open buttons
5. Error and Existing buttons
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Answer to Review QuestionAnswer to Review Question

The Item Templates Summary window has the
following buttons:
1. Engineering and Inventory buttons
2. Utility and  Item buttons
3. Search and Query buttons
4. New and Open buttons
5. Error and Existing buttons

The Item Templates Summary window has the
following buttons:
1. Engineering and Inventory buttons
2. Utility and  Item buttons
3. Search and Query buttons
4. New and Open buttons
5. Error and Existing buttons
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Viewing Item InformationViewing Item Information

• View revisions, attributes, and categories using
the Find Item Information window

• Depending on the function security assigned to
your responsibility, view the information for:
– Single organization only
– Single organization and its master

organization
– All organizations

• View revisions, attributes, and categories using
the Find Item Information window

• Depending on the function security assigned to
your responsibility, view the information for:
– Single organization only
– Single organization and its master

organization
– All organizations

(N) Prototypes > Items > View Item Details

(Help) Oracle Inventory > Items > Viewing Item Attributes
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Viewing Item RevisionsViewing Item Revisions

The Revisions button displays:
– Revision
– Description
– Organization
– Dates and time
– Engineering change orders (ECOs)

The Revisions button displays:
– Revision
– Description
– Organization
– Dates and time
– Engineering change orders (ECOs)

(N) Prototypes > Items > View Item Details (B) Revisions

(Help) Oracle Inventory > Items > Viewing Item Attributes
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Viewing Item Attributes
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Viewing Item AttributesViewing Item Attributes

The Attributes button displays:
– Description of the item
– Group
– Attribute
– Organization
– Value
– Control level

The Attributes button displays:
– Description of the item
– Group
– Attribute
– Organization
– Value
– Control level

(N) Prototypes > Items > View Item Details (B) Attributes

(Help) Oracle Inventory > Items > Viewing Item Attributes
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Viewing Item Categories
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Viewing Item CategoriesViewing Item Categories

The Categories button displays:
– Category set
– Organization
– Category
– Control level

The Categories button displays:
– Category set
– Organization
– Category
– Control level

(N) Prototypes > Items > View Item Details (B) Categories

(Help) Oracle Inventory > Items > Viewing Item Attributes
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Item Status Codes:
Status Attributes

Item Status Codes:
Status Attributes

• Use statuses to control values of certain item
attributes which affect the functionality of an item.

• A status code controls certain item attributes
designated as status attributes.

• When you update the definition of a status, all
items to which it is assigned are also updated.

• Use statuses to control values of certain item
attributes which affect the functionality of an item.

• A status code controls certain item attributes
designated as status attributes.

• When you update the definition of a status, all
items to which it is assigned are also updated.

XYZXYZ

Item Status and Status Codes

An Item Status Code has a user-defined set of Yes/No values for the status
attributes. The values are applied to the status attributes when you choose an Item
Status Code when defining an item. For example, assume you define an Item
Status named Prototype with all status attributes set to Yes except for Customer
Orders Enabled. Next, you define another Item Status, Active, with all status
attributes set to Yes. In the beginning of a product development cycle, assign the
status code Prototype to an item so that you cannot place the item on a sales order.
Later, assign the status code Active to allow all functions for the item.

Pending Statuses

Use pending statuses to automatically update an item's status on a specified date.
For each item, specify a list of pending statuses and the corresponding effective
dates.
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Item Status Codes:
Status Attributes

Item Status Codes:
Status Attributes

The status attributes are:The status attributes are:

XYZXYZ

BOM allowed
Build in WIP
Customer orders
enabled
Transactable

Internal orders
enabled
Invoicable
Purchasable
Stockable

Change Responsibility: (N) Oracle Inventory > Setup > Items > Status
Codes

(Help) Oracle Inventory > Setting Up > Item Setup and Control >
Defining Item Status Codes
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Organization AssignmentsOrganization Assignments

• Use the Organization Assignment window to
assign an item to an organization.
– Displays

– Organization
– Name
– Primary UOM
– The Assign All button/individual assign

check boxes.
– The Org Attributes button launches the

Engineering Organization Item window.

• Use the Organization Assignment window to
assign an item to an organization.
– Displays

– Organization
– Name
– Primary UOM
– The Assign All button/individual assign

check boxes.
– The Org Attributes button launches the

Engineering Organization Item window.

Enabling Organization Assignments

Use this window to enable engineering items and inventory items in organizations
in the same way that you use the corresponding Oracle Inventory window to
enable production items in organizations. It is not recommended to check Assign
All. There are many times items should not be assigned to an organization,
especially an engineering item.

(N) Prototypes > Items > Master Item (M) Tools > Organization
Assignment (B) Assign All

(Help) Oracle Inventory > Items > Assigning Items to Organizations
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Creating and Changing Engineering
Organization Items

Creating and Changing Engineering
Organization Items

The Engineering Organization Item window allows
users to create and change item attributes in
organizations using the the following tabs:

The Engineering Organization Item window allows
users to create and change item attributes in
organizations using the the following tabs:

Main
Inventory
Bill of Materials
(BOM)
Costing
Purchasing

Receiving
Physical attributes
General
MPS/MRP
Planning

Lead times
WIP
OM
Invoicing
Service
Web option

Creating and Changing Engineering Organization Items

Use this window to create and change item attributes in organizations in the same
way that you use the corresponding Oracle Inventory window to create and
change production item attributes in organizations.

(N) Prototypes > Items > Master Item (M) Tools > Organization
Assignment (B) Org Attributes

(Help) Oracle Inventory > Items > Assigning Items to Organizations
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Creating Item Catalog GroupsCreating Item Catalog Groups

• Define a catalog group with the Item Catalog
window.

• Use descriptive elements for searching or to
standardize descriptions.

•  Displays
– Name
– Description
– Inactive on

• Define a catalog group with the Item Catalog
window.

• Use descriptive elements for searching or to
standardize descriptions.

•  Displays
– Name
– Description
– Inactive on

Creating Item Catalog Groups

Use the same item catalog groups in Oracle Engineering to work with engineering
items that you use in Oracle Inventory to work with production items.

(N) Prototypes > Items > Catalog Groups

(Help) Oracle Inventory > Setting Up > Item Setup and Control > Item
Cataloging > Defining Item Catalog Groups
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Review QuestionReview Question

When viewing items the three viewing functions
include:
1. Summary, searched, and process sets
2. Attributes, revisions, and categories
3. Defined, template, and production
4. Assigned, material, and organization
5. Inventory, BOM, and manual

When viewing items the three viewing functions
include:
1. Summary, searched, and process sets
2. Attributes, revisions, and categories
3. Defined, template, and production
4. Assigned, material, and organization
5. Inventory, BOM, and manual



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Oracle BOM and Engineering: Defining and Maintaining Engineering Items
Chapter 1 - Page 41

Answer to Review Question

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Answer to Review QuestionAnswer to Review Question

When viewing items the three viewing functions
include:
1. Summary, searched, and process sets
2. Attributes, revisions, and categories
3. Defined, template, and production
4. Assigned, material, and organization
5. Inventory, BOM, and manual

When viewing items the three viewing functions
include:
1. Summary, searched, and process sets
2. Attributes, revisions, and categories
3. Defined, template, and production
4. Assigned, material, and organization
5. Inventory, BOM, and manual
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Review QuestionReview Question

All of the following are tabs in the Engineering
Organization Item window except:
1. Purchasing
2. General
3. Physical attributes
4. Web options
5. Payables

All of the following are tabs in the Engineering
Organization Item window except:
1. Purchasing
2. General
3. Physical attributes
4. Web options
5. Payables
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Answer to Review QuestionAnswer to Review Question

All of the following are tabs in the Engineering
Organization Item window except:
1. Purchasing
2. General
3. Physical attributes
4. Web options
5. Payables

All of the following are tabs in the Engineering
Organization Item window except:
1. Purchasing
2. General
3. Physical attributes
4. Web options
5. Payables
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Creating Cross ReferencesCreating Cross References

• Cross-reference types define relationships
between items and entities such as old item
numbers or supplier item numbers.

• For example, you can create a cross-reference
type old to track the old item numbers, and a type
supplier to track supplier part numbers.

• Cross-reference types define relationships
between items and entities such as old item
numbers or supplier item numbers.

• For example, you can create a cross-reference
type old to track the old item numbers, and a type
supplier to track supplier part numbers.
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Creating Cross ReferencesCreating Cross References

• Cross Reference Types window displays
– Type
– Description
– Inactive on

• The Assign button displays.
– Items
– Organizations
– Values
– Descriptions

• Cross Reference Types window displays
– Type
– Description
– Inactive on

• The Assign button displays.
– Items
– Organizations
– Values
– Descriptions

(N) Prototypes > Items > Cross References
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Related ItemsRelated Items

• Define relationships between items.
• This allows you to search for items through these

relationships.
• The New button

– Allows you to enter a new relationship.
– From/to associations

• The Find button
– Allows you to search relationships.

• Define relationships between items.
• This allows you to search for items through these

relationships.
• The New button

– Allows you to enter a new relationship.
– From/to associations

• The Find button
– Allows you to search relationships.

(N) Prototypes > Items > Related Items

(Help) Oracle Inventory > Items > Defining Item Relationships
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Item DocumentsItem Documents

• Use the Documents window to add existing
documents, or create new attachments in the
document catalog. Use the same corresponding
Oracle Inventory window to create and change
production items.

• These documents will then be available for use as
attachments from the Attachments window.

• Creating a document in the Documents window is
much like creating an attachment in the
Attachments window with the addition of security,
usage, and effective date information.

• Use the Documents window to add existing
documents, or create new attachments in the
document catalog. Use the same corresponding
Oracle Inventory window to create and change
production items.

• These documents will then be available for use as
attachments from the Attachments window.

• Creating a document in the Documents window is
much like creating an attachment in the
Attachments window with the addition of security,
usage, and effective date information.
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Guided Practice AGuided Practice A

1. Creating Engineering Items

1. Use the following table to create engineering items.
(N) Prototypes > Items > Master Items (displays the Engineering
Master Item window) Enter the item number, description, and user item
type. If a flexfield is displayed click the OK button. XX represents your
initials or team. Note the item number may require five numbers after your
initials e.g., XX1000 = XX10000.
2. Save the item.
3. Assign the items to an organization that your instructor specifies e.g.,
M2.
Tools > Org Assignment > e.g., M2 checkbox  (displays the
Organization Assignment window)
4. Save the item and close the window.
5. Choose the new record icon.

Copied items

1. Enter the item number and description.
2. Copy the item. Tools > Copy From, enter copy item number (B)
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Done button (displays the Copy From window).
3. Save the item.
4. Assign the items to an organization (see above navigation path).
5. Save the item.
6. Choose the new record icon.

Item Number Description User Item Type Copied Item
XX1000 Pentium Computer  Finished Good
XX1010 17" Monitor  Purchased Item
XX1020 101 Keyboard XX1010
XX1030 Mouse XX1010
XX1040 CPU Chassis Subassembly
XX2010 Motherboard XX1040
XX2011 New Motherboard XX2010
XX2020 Serial Board XX1010
XX2030 1.6GB Hard Drive XX1010
XX2040 3.5 Disk Drive XX1010
XX3010 Blank Board XX1010
XX3020 586 133mhz IC XX1010
XX3030 Resistor XX1010
XX3031 New Resistor XX3030
XX3040 Integrated Circuit XX1010
XX3041 Item to Delete XX1010 (Do
not assign an organization for XX3041)

2. Using the Master Items window

1. Query all of your items. Choose view and select query by example,
enter.
2. Enter XX% and from the menu bar choose view and select query by
example, run.
3. Query all Pentium computers.
4. Query all of your items in the organization that your instructor assigned.
(N) Organization Items, verify that your items are in the assigned
organization.

3. Using (N) View item detail, view one or more of your items
(displays the Find Item Information window).
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1. Enter your query and choose the Attributes button. What group does
 the engineering item belong to? What is the value?

4. Try to define your items using an Oracle Inventory
responsibility that your instructor assigns. What is the result?

Repeat steps 1-3. Although in step 1 add PR at the end of the numbers to
differentiate them from the item numbers in Oracle Engineering e.g.,
XX1000 = XX1000PR.
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Deleting Product Information

ItemsItems

Bills ofBills of
material andmaterial and
componentscomponents

DeleteDelete

ArchiveArchive

Routings andRoutings and
OperationsOperations

Deletion Groups

When you decide that product information is no longer useful, or input
incorrectly, you can delete or archive it.

• If you delete information, you remove it from the active data storage area
and you cannot:

– Manipulate or view it on forms.

– Retrieve it again by any means.

• If you archive information, you store deleted information in another
storage area of the database. Oracle Applications provides no functions for
you to:

– View the archived information.

– Restore the archived information to the active data storage area.
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Information That You Can Delete
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Information That You Can Delete

OracleOracle
InventoryInventory

OracleOracle
Bills of MaterialBills of Material

OracleOracle
EngineeringEngineering

 Production
and Bill
Routing

 Production Bills
of Material,

Routing,
Component, and

Operation Bill
Routing

 Engineering
items, Bills of

Material,
Routing,

Component,
Operation, Bill
Routing, and

Item Bill Routing

Information That You Can Delete

Set up groups of entities to check, delete and optionally archive. Entities can
include items, bills of material, components, routings, or operations.
What entities you can delete depends on what Oracle application you are currently
using and what applications you have installed.

• If you are using Oracle Bills of Material, you can delete only bills,
routings, components, and operations.

• If you are using Oracle Engineering, you can delete any engineering entity
except ECOs.

• If you are using Oracle Inventory and you do not have Bills of Material
installed, you can only delete manufacturing items.

• If you are using Inventory and you do have Bills of Material installed, you
can delete only items, bills, and routings.

Using Oracle Engineering, you can delete all of the information types that you
can delete using Oracle Inventory and BOM, but for  engineering data only. In
addition, you can delete engineering change order information.
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Deletion Process
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Deletion Process

Delete
requests

Delete
constraints

----------------------------

----------------------------
----------------------------

----------------------------

----------------------------
----------------------------

----------------------------
ErrorError

OKOK

Deletion Process

Deleting physically removes information from the database tables. Deleted bill or
routing information can be archived to database tables. (You cannot archive item-
level information.) You can then write custom programs to report on the archived
data. Summary information is saved for all deletion groups. You can report on
deletion groups.

Several deletion constraints are installed with BOM. However, you can define
custom deletion constraints. If what you are attempting to delete does not pass
deletion constraints, it is not deleted. For example, you can define a constraint that
prevents you from deleting a bill of material for an assembly that has an item
status of active.

When you delete an entire bill, you delete all the components for the assembly
along with their reference designators and substitute items. When you delete a
routing, all operations are deleted. For both bills and routings, any links to
attachments are severed.

Oracle Work in Process reflects any changes to the bills or routings using the
delete functionality only if you re-explode the bill or routing in Work in Process.
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Deletion Group Details
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Deletion Group DetailsDeletion Group Details

• Engineering Deletion Group window
– Group name, type, description, last submitted,

and archive enable box.
– Entities to delete: Details and Results tab.

– Details
– Item, description, organization, type,

alternative
– Results

– Item, description, status, date

• Engineering Deletion Group window
– Group name, type, description, last submitted,

and archive enable box.
– Entities to delete: Details and Results tab.

– Details
– Item, description, organization, type,

alternative
– Results

– Item, description, status, date

(N) Prototypes > Items > Delete Groups

(Help) Oracle Bills of Material >  > Bills of Material > Deleting Items
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Deletion Group Details and ResultsDeletion Group Details and Results

• The Error button reviews why the deletion failed
(constraints defined in setup).

• The delete Group button submits the deletion
group to the concurrent manager.

• The Check Group button verifies whether any
deletion constraints are violated.

• The Error button reviews why the deletion failed
(constraints defined in setup).

• The delete Group button submits the deletion
group to the concurrent manager.

• The Check Group button verifies whether any
deletion constraints are violated.

Errors

Change Responsibility: (N) Oracle BOM > Delete Groups (B) Errors

(Help) Oracle Bills of Material > Reports and Processes > Delete
Items Report
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For Reviewing History and Purging ECOs
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For Reviewing History and Purging ECOsFor Reviewing History and Purging ECOs

How?
• By submitting a request to view information about

deletion groups.
– Selecting the request or request set to be

submitted.
– Defining a submission schedule
– Providing completion options

How?
• By submitting a request to view information about

deletion groups.
– Selecting the request or request set to be

submitted.
– Defining a submission schedule
– Providing completion options

Change Responsibility: (N) Oracle Bills of Material > Reports > Delete
Groups

In Engineering: (N) ECOs > Delete

(Help) Oracle Bills of Material > Reports and Processes > Delete
Items Report
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Review QuestionReview Question
What is the correct deletion process?
1. Press the Check Group button and acknowledge
that you deleted the correct item.
2. Archive the request, create a delete group, and
then delete the item.
3. Create the delete group, add items to the group,
save the delete group, check group for deletion
constraints violations, and submit for deletion.
4. Create request delete group, request identifies
delete constraints, and the item goes in the trash.
5. Create request delete group, archive the request,
and identify the item.

What is the correct deletion process?
1. Press the Check Group button and acknowledge
that you deleted the correct item.
2. Archive the request, create a delete group, and
then delete the item.
3. Create the delete group, add items to the group,
save the delete group, check group for deletion
constraints violations, and submit for deletion.
4. Create request delete group, request identifies
delete constraints, and the item goes in the trash.
5. Create request delete group, archive the request,
and identify the item.
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Answer to Review QuestionAnswer to Review Question
What is the correct deletion process?
1. Press the Check Group button and acknowledge
that you deleted the correct item.
2. Archive the request, create a delete group, and
then delete the item.
3. Create the delete group, add items to the group,
save the delete group, check group for deletion
constraints violations, and submit for deletion.
4. Create request delete group, request identifies
delete constraints, and the item goes in the trash.
5. Create request delete group, archive the request,
and identify the item.

What is the correct deletion process?
1. Press the Check Group button and acknowledge
that you deleted the correct item.
2. Archive the request, create a delete group, and
then delete the item.
3. Create the delete group, add items to the group,
save the delete group, check group for deletion
constraints violations, and submit for deletion.
4. Create request delete group, request identifies
delete constraints, and the item goes in the trash.
5. Create request delete group, archive the request,
and identify the item.
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Creating documents in the Documents window is
much like creating an attachment in the Attachment
window, but with the addition of:
1. Better functionality, saving ability, and easy of use.
2. Security, usage, and effective date information.
3. Multi tasking, help references, and visibility.
4. Windows, folders, and opening and collapsing
trees.
5. Security, sequencing, and effective date
information.

Creating documents in the Documents window is
much like creating an attachment in the Attachment
window, but with the addition of:
1. Better functionality, saving ability, and easy of use.
2. Security, usage, and effective date information.
3. Multi tasking, help references, and visibility.
4. Windows, folders, and opening and collapsing
trees.
5. Security, sequencing, and effective date
information.
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Creating documents in the Documents window is
much like creating an attachment in the Attachment
window, but with the addition of:
1. Better functionality, saving ability, and easy of use.
2. Security, usage, and effective date information.
3. Multi tasking, help references, and visibility.
4. Windows, folders, and opening and collapsing
trees.
5. Security, sequencing, and effective date
information.

Creating documents in the Documents window is
much like creating an attachment in the Attachment
window, but with the addition of:
1. Better functionality, saving ability, and easy of use.
2. Security, usage, and effective date information.
3. Multi tasking, help references, and visibility.
4. Windows, folders, and opening and collapsing
trees.
5. Security, sequencing, and effective date
information.
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In this lesson, you should have learned how to:
• Create engineering items
• Copy from item templates
• Search for engineering items
• View item information and revise item attributes
• Enable organization assignments
• Create item catalog groups
• Create cross references, relationships and

documents
• Create deletion groups

In this lesson, you should have learned how to:
• Create engineering items
• Copy from item templates
• Search for engineering items
• View item information and revise item attributes
• Enable organization assignments
• Create item catalog groups
• Create cross references, relationships and

documents
• Create deletion groups
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1. Create a deletion group component XX3010 from subassembly
XX2010 (N) Prototypes > Delete Group

1. Enter XXDELETE as the group.
2. Enter XXDELETE group as the description.
3. Select item as the type.
4. Select XX3041 as the item from the LOV.
5. The description, organization and type will default.
7. Choose the disk icon to save.

2. Check the delete group for constraint violations (seeded or
user defined) (N) Prototypes > Delete Group (B) Check Group
button

1. Record request number.
2. From the menu bar choose view and select requests.
3. Choose the Find button (verify that the request is completed normal) close

window.
4. Re-query your deletion group.
5. Choose the Results tab and verify that the status is OK.

3. Perform the deletion (N) Prototypes > Delete Group (B)
Delete Group button
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1. Record request number.
2. From the menu bar choose view and select requests.
3. Choose the Find button (verify that the request is completed normal)
close window.
4. In the Master Item window re-query your item and verify that it was
deleted.

4. Try deleting another item that you created. Was there any
deletion constraints?
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